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Preface
The Oracle Insurance Insight Installation Guide provides instructions for installing and 
configuring Oracle Insurance Insight (OII) V7.0.2 and lists all required prerequisite software.

VERSION
This manual corresponds to Oracle Insurance Insight (OII) version 7.0.2.

AUDIENCE
This manual is intended for users and administrators with knowledge of the insurance 
industry. 

RELATED OII DOCUMENTATION
For more information, refer to the following documents:

• Oracle Insurance Insight Release Notes - These document describes the latest 
enhancements and updates to OII as well as issues that have been resolved in this version.

• Oracle Insurance Insight Implementation Guide - This manual describes the concepts 
and steps involved in implementing the OII system.

• Oracle Insurance Insight Administration Guide - This manual describes how to create 
and configure the required OII users and groups within OBIEE.

• Oracle Insurance Insight User Guide - OII uses OBIEE 11g as its front end interface, 
providing a set of dashboards, reports, and query-building tools to use to analyze the OII 
data. This manual describes how to configure and run the OII reports as well as use the 
OBIEE analytic features to build custom queries to run against the OII data. 

• Oracle Insurance Insight Warehouse Palette User Guide - This manual describes how to 
use the Warehouse Palette, an application that provides users with an easy-to-use 
interface to create and configure a Line of Business (LOB) and “publish” the LOB for 
incorporation into the OII system. 

• Oracle Insurance Insight Data Dictionary - The data dictionary for the OII system.
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vi

OII DOCUMENTATION ON THE ORACLE TECHNOLOGY NETWORK 
(OTN)

The OII documentation set is packaged with the product release. You can also obtain these 
guides online thought the Oracle Technology Network (OTN) at this address:
http://www.oracle.com/technetwork/documentation/insurance-097481.html

CUSTOMER SUPPORT
If you need help with OII, please log a Service Request using My Oracle Support at”
https://support.oracle.com
Address any additional inquiries to:
Oracle Corporation
World Headquarters
500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200
oracle.com
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Chapter 1

System Information

CONFIGURATION AND INSTALLATION REQUIREMENTS

REQUIRED INFORMATION
You must have the following information on hand for the OII installation:

• Oracle Database server name or IP Address

• Oracle Database host name

• Oracle Database user name/password

The Domain user account which will have Administrator privilege on local machine and 
database access rights on the database server.

ADMINISTRATOR PRIVILEGES
The user must log in with the Domain user account mentioned above on the machine on 
which you are installing OII.
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DATABASE AND APPLICATION SERVER ENVIRONMENTS

Database Server Environment
Operating System:

• Windows Server 2003 (32-bit)

Prerequisite Software:

• Oracle Database Enterprise Edition 11g (11.2.0.1.0)

• Oracle Application Express (4.0.2)

Hardware Requirements:

• CPU: (4) 2GHz processors or higher

• RAM: 8GB or higher

Application Server Environment
Operating System:

• Windows Server 2003 (32-bit)

Prerequisite Software:

• Repository Creation Utility (11.1.1.5.0)
• OBIEE 11g (11.1.1.5.0) Includes the following components:

• Oracle WebLogic Application Server 11g
• Oracle Fusion Middleware (11.1.1.5.0)
• JDK 1.6.0

• Oracle Application Express Listener (1.1.0.60.10.38)
• Oracle Data Integrator (11.1.1.5.0)
• Web Browsers:

• Microsoft Internet Explorer Version 7.0 or higher 

or

• Mozilla Firefox 3.5 or higher

Hardware Requirements:

• CPU: 2GHz or higher
• RAM: 2GB or higher
• Disk Space: 6.5GB 
• Temporary Disk Space: 4GB
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Chapter 2

Choosing the Type of Installation
OII 7.0 or 7.0.1 must be installed on your system in order to upgrade to OII 7.0.2. Depending upon 
whether or not you have already installed OII 7.0 or 7.0.1, you must perform one of these types of 
installations:

Clean Installation 
A clean installation assumes that you have never installed any version of OII on your system. Users 
who are performing a clean installation of OII 7.0.2 must:

• Install all prerequisite software required to run OII

• Run the OII installer to install the OII 7.0 components 

• Perform all manual post-installation steps to configure and install OII 7.0.2

Upgrade Only

If this is a Clean Installation of OII 7.0.2... If this is an Upgrade to OII 7.0.2...

This type of installation assumes that you have already installed either  
OII 7.0 or 7.0.1 on your system and only need to upgrade to OII 7.0.2.

IMPORTANT OII 7.0.2 requires OBIEE 11g and Oracle Data Integrator 11.1.1.5.0. Even if you have 
already installed OII 7.0/7.0.1 you will still need to install these two software components 
before you can upgrade to OII 7.0.2.

Go directly to this chapter: 

Chapter 3: Installing the Prerequisite Software for OII.

Go directly to this chapter:
Chapter 14: Upgrading to OII 7.0.2
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Chapter 3 

Installing the Prerequisite Software for OII
The following prerequisite software must be installed and configured on your system prior to 
installing OII 7.0.2.

DATABASE SERVER SOFTWARE
The following software in this section must be installed on the database server:

• Oracle Database Enterprise Edition 11g

• Oracle Application Express (APEX) 4.0.2

ORACLE DATABASE ENTERPRISE EDITION 11G
Required Version: Oracle Database Enterprise Edition 11g (11.2.0.1.0)

Download:  Download the required version of the Oracle Database from the Oracle Technology 
Network (OTN):
http://www.oracle.com/technetwork/database/enterprise-edition/downloads/
index.html?ssSourceSiteId=ocomen

Documentation: Download the full documentation for Oracle Database from OTN:
http://www.oracle.com/technetwork/database/enterprise-edition/documentation/index.html

Database Server Application Server
Oracle Database Enterprise Edition Repository Creation Utility

Oracle Application Express (APEX) OBIEE

Oracle Data Integrator

Oracle Application Express Listener

http://www.oracle.com/technetwork/database/enterprise-edition/downloads/index.html?ssSourceSiteId=ocomen
http://www.oracle.com/technetwork/database/enterprise-edition/documentation/index.html
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ORACLE APPLICATION EXPRESS (APEX)
Required Version:  Oracle Application Express (APEX) Release 4.0.2

Download: Download the required version of APEX from the Oracle Technology Network (OTN):
http://www.oracle.com/technetwork/developer-tools/apex/downloads/index.html

Documentation: Download the full documentation for APEX from OTN:
http://www.oracle.com/technetwork/developer-tools/apex/documentation/index.html

APEX Installation Notes
During the installation of the Oracle Database an earlier version of APEX (3.0.2) is automatically pre-
installed on the same machine. OII 7.0.2, however, requires APEX 4.0.2 in order to run.

APPLICATION SERVER SOFTWARE
The following software in this section must be installed on the application server:

• Repository Creation Utility (RCU)

• Oracle Business Intelligence Enterprise Edition (OBIEE) 11G

• Oracle Application Express Listener

• Oracle Data Integrator 11g

REPOSITORY CREATION UTILITY (RCU)
Required Version: RCU (11.1.1.5.0)

Download:  Download the required version of RCU from the Oracle Technology Network (OTN):
http://www.oracle.com/technetwork/middleware/bi-enterprise-edition/downloads/biee-111150-
393613.html

Documentation: The instructions for using RCU is contained in the OBIEE 11g installation guide. 
Download the full documentation for OBIEE 11g from OTN:
http://www.oracle.com/technetwork/middleware/bi-enterprise-edition/documentation/index.html

RCU Operation Notes
• RCU is required for creating database schemas in OBIEE 11g. 

• When you run RCU, only select the OBIEE schema option. DO NOT select ODI.

http://www.oracle.com/technetwork/developer-tools/apex/downloads/index.html
http://www.oracle.com/technetwork/developer-tools/apex/documentation/index.html
http://www.oracle.com/technetwork/middleware/bi-enterprise-edition/documentation/index.html
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ORACLE BUSINESS INTELLIGENCE ENTERPRISE EDITION (OBIEE) 11G
Required Version: OBIEE (11.1.1.5.0)

Download:  Download the required version of OBIEE from the Oracle Technology Network 
(OTN):
http://www.oracle.com/technetwork/middleware/bi-enterprise-edition/downloads/biee-111150-
393613.html

Documentation: Download the full documentation for OBIEE 11g from OTN:
http://www.oracle.com/technetwork/middleware/bi-enterprise-edition/documentation/index.html

OBIEE Installation Notes
• The following software is installed during the OBIEE 11g installation:

• Oracle Fusion Middleware Control

• Oracle WebLogic Application Server 11g

• JDK 1.6.0

ORACLE APPLICATION EXPRESS LISTENER
Required Version:  Oracle Application Express (APEX) Listener (1.1.2.131.15.23)

Download: Download the required version of APEX Listener f rom the Oracle Technology 
Network (OTN):
http://www.oracle.com/technetwork/developer-tools/apex-listener/downloads/index.html

Documentation: Download the full documentation for APEX Listener from OTN:
http://www.oracle.com/technetwork/developer-tools/apex-listener/documentation/index.html

Installation Notes
APEX requires one of three applications to serve as a gateway to proxy requests between the Web 
browser and APEX. We advise using Oracle Application Express Listener as the preferred option. 
Two other alternatives, Oracle HTTP Server and mod_plsql or the embedded PL/SQL gateway are 
also available. You are free to use any of these options based upon your needs but Oracle Application 
Express Listener is the one that is recommended for use with OII. Refer to the APEX documentation 
for more information.

http://www.oracle.com/technetwork/middleware/bi-enterprise-edition/documentation/index.html
http://www.oracle.com/technetwork/developer-tools/apex-listener/documentation/index.html
http://www.oracle.com/technetwork/developer-tools/apex-listener/downloads/index.html
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ORACLE DATA INTEGRATOR (ODI)
Required Version: Oracle Data Integrator 11g (11.1.1.5.0)

Download: Download the required version of ODI from the Oracle Technology Network:
http://www.oracle.com/technetwork/middleware/data-integrator/downloads/index.html

Documentation: Download the full documentation for ODI from OTN:
http://www.oracle.com/technetwork/middleware/data-integrator/documentation/index.html

ODI Installation Notes
When you are running the ODI installer, make sure you select these settings on the following screen:

• On the Select Installation Type screen, select the “Standalone Installation” and make sure that 
the “ODI Studio (with local agent) option” is checked.

Figure 1: Select “Standalone Installation” and “ODI Studio”

http://www.oracle.com/technetwork/middleware/data-integrator/documentation/index.html
http://www.oracle.com/technetwork/middleware/data-integrator/downloads/index.html
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• On the “Repository Configuration” screen, select the “Skip Repository Configuration” option.

Figure 2: Select “Skip Repository Configuration”
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OPENING THE ORACLE FUSION MIDDLEWARE CONTROL AND THE 
WEBLOGIC SERVER ADMINISTRATION CONSOLE

The Oracle Fusion Middleware Control and the Oracle WebLogic Server Administration 
Console which are installed with OBIEE 11g are used to configure various OII components 
throughout the installation. This section describes how to access both of these components.

Opening the Oracle Fusion Middleware Control 
1. Launch the Enterprise Manager by entering the following URL in your browser:

http://<hostname>:7001/em

Figure 3: Enterprise Manager Login Screen

Note In the above URL, <hostname> can be the server name or IP address where you 
installed OBIEE.
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2. Log into Enterprise Manager using the administrator name and password that was specified 
during the OBIEE installation. The Oracle Fusion Middleware Control will open.

Figure 4: Oracle Fusion Middleware Control

Opening the Oracle WebLogic Server Administration Console
Open the WebLogic Server Administration Console using one of the following methods.

Method 1: Open the WebLogic Server Administration Console in the Fusion 
Middleware Control
1. Launch the Enterprise Manager by entering the following URL in your browser:

http://<hostname>:7001/em

Note In the above URL, <hostname> can be the server name or IP address where you 
installed OBIEE.
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Figure 5: Enterprise Manager Login Screen

2. Log into Enterprise Manager using the administrator name and password that was specified 
during the OBIEE installation. The Oracle Fusion Middleware Console will open.

Figure 6: Oracle Fusion Middleware Console

3. In the navigation tree in the left pane expand the WebLogic Domain node and select the 
bifoundation_domain.

4. Click the Oracle WebLogic Server Administration Console link in theSummary region.

5. The Oracle WebLogic Server Administration Console login page is displayed.
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Method 2: Using a URL
1. Launch WebLogic by entering the following URL in your browser:

http://<hostname>:7001/console

The WebLogic Server Administration Console login screen will open:

Figure 7: WebLogic Server Administration Console Login Screen

2. Enter the administrator user name and password for the server domain that was specified during 
the OBIEE installation process. The WebLogic Administration Console opens:

Figure 8: WebLogic Server Administration Console

Note In the above URL, <hostname> can be the server name or IP address where you 
installed OBIEE.
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WHAT’S THE NEXT STEP IN THE INSTALLATION?
Once all of the prerequisite software has been installed you must create a database connection using 
the Net Manager tool under OBIEE 11g. Go to:

• Chapter 4: Creating a Database Connection
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Chapter 4 

Creating a Database Connection
Define a database connection named Insight700 using the Net Manager tool under OBIEE 11g. You 
will need this connection later on when configuring Oracle Data Integrator and OBIEE.

1. Open a command window and go to the folder:

<MW_HOME>\Oracle_BI1\bin
For example:
C:\Oracle\Middleware\Oracle_BI1\bin

2. At the command line type the following command to launch the Net Manager:

Note <MW_HOME> is the name of the Middleware Home directory that you specified when 
you installed OBIEE 11g. The OBIEE Installer created the home directories for OBIEE 
and WebLogic and their respective components under this directory. For the sake of 
consistency we will refer to <MW_HOME> throughout this manual as 
C:\Oracle\Middleware.

launch.exe "<MW_HOME>\Oracle_BI1\network\tools" ..\network\tools\netmgr.cl
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Figure 9: Oracle Net Manager Welcome Screen

3. In the menu on the left, expand the Local node and highlight the Service Naming node.

4. Click the ‘+’ button to the left of the menu tree. The Net Service Wizard: Welcome screen 
appears.

5. Enter Insight700 as the Net Service Name. 

Figure 10: Welcome Screen
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6. Click on Next. The Protocol screen opens.

Figure 11: Protocol Screen

7. Keep the default selection (“TCP/IP (Internet Protocol)”) and click on Next. The Protocol 
Settings screen opens.

Figure 12: Protocol Settings Screen

8. Enter the following settings on the Protocol Settings screen:

• Host Name: Enter the host name or address where the Oracle database server is located.

• Port Number: Keep 1521 as the default. This is the standard default for Oracle databases.
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9. Click Next. The Service screen opens. 

Figure 13: Service Screen

10. Specify the following settings on the Service Name screen:

• Service Name: The Service Name name of the database you wish to access. For this example 
we will use the orcl as the Service Name.

• Connection Type: Accept Database Default (this is the default selection).

11. Click on Next. The Test screen opens.

Figure 14: Test Screen
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12. Click on the Test button. Net Manager will first attempt to connect to the database using the 
default username and password (scott/tiger) and it will return an error message.

Figure 15: Connection Test Failed

13. Click on the Change Login button. A dialog box will appear in which you can specify a 
username and password that you know exists.

Figure 16: Change Login

14. Click OK to close the Change Login dialog box.
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15. Click the Test button. A message indicating a successful connection will appear on the screen:

Figure 17: Connection Test Successful

16. Click the Close button to close the Connection Test screen.
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17. Click on Finish on the Test screen. The main Net Manager screen opens and the connection you 
just created ill appear under the Service Naming folder.

Figure 18: The New Connection Appears Under Service Naming Folder

18. Click on File>Save Network Configuration to save the connection.

19. Select File>Exit to close the screen.

WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step is to install OII 7.0. Go to:

• Chapter 5: Installing OII 7.0
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Chapter 5

Installing OII 7.0
Users must first install OII 7.0 to their system before they can upgrade to OII 7.0.2. This 
chapter describes the steps for downloading the OII 7.0 installation package and installing 
OII 7.0 to your system. 

INSTALLATION PREREQUISITES
Before you can begin the installation you must have the following information available:
• Oracle database server name or IP Address
• Oracle database Host Name
• Oracle database SID or Service Name
• Oracle database Port number
• Oracle database user name and password

STEP 1: DOWNLOAD THE OII INSTALLATION FILE
OII is available from the Oracle E-Delivery system as a downloaded .ZIP file:
http://edelivery.oracle.com/

1. Obtain the OII installation ZIP file from Oracle E-Delivery and download it to your 
machine.

2. Unzip the file. 

STEP 2: DOWNLOAD THE OII 7.0.2 UPGRADE PACKAGE
The OII Upgrade Package for OII 7.0.2 is available from the Oracle E-Delivery system as a 
.ZIP file at: http://edelivery.oracle.com.

1. Obtain the OII upgrade ZIP file (e.g., Insight702Package.zip) from Oracle E-Delivery 
and download it to your machine. 
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2. Unzip the upgrade package. It will place a folder on your system bearing the same name as the 
ZIP file (e.g., Insight702Package). The following files and directories will appear under the 
unzipped folder:

Figure 19: Upgrade Files for OII 7.0.2

WHAT’S IN THE UPGRADE PACKAGE?

root folder
• version.txt - A text file containing the version of the package.

• 702Upgrade.jar - The main upgrade utility, executable jar file.

• application.properties - A configuration file that contains the parameters for the upgrade utility.

• upgrade.bat - A windows batch file to execute the upgrade utility.

• upgrade.sh - A UNIX script file to execute the upgrade utility.

app folder
The app folder contains the updated content for agent and additional content for OII 7.0.2. 

install folder
The install folder contains the updated content for APEX, the database, OBIEE and the ODI Wrapper 
Service:

apex
This folder contains the updated version of the Warehouse Palette application, wp_apex.sql.



Step 3: Run the OII 7.0 Installer

27

db
This folder contains all database related updates. 

obiee
This folder contains all OBIEE related updates.

wrapper
This folder contains the updated version of the OdiWrapperService.ear file.

STEP 3: RUN THE OII 7.0 INSTALLER
1. Double-click on the file: C:\<OII700>\cd\disk1\install\setup.exe 

The Welcome screen of the OII Installer opens. 

Figure 20: Installer Welcome Screen
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2. Click Next. The Specify Home Details screen opens. When you first arrive at this screen the 
Name and Path fields are already populated with the default installation name and the full 
path.where OII will be installed.

Figure 21: The Default Settings on the Specify Home Details Screen

3. Specify the installation name and the full default path where you want to install OII.

• Name: The Name field refers to the current Oracle home name for this particular installation 
of OII. Each Oracle home name has a unique name that distinguishes it from all other Oracle 
home names for other Oracle products on your machine. The Oracle home name is 
commonly used in Start menus items and to identify service names if the particular product 
is run as a Windows service.

• Path: This is the full path to the home directory where all OII files will be installed. It is 
strongly recommended that you enter a distinct path for the OII installation directory. For 
example: C:\Oracle\Insight_Home

Note The Oracle home name and the OII home directory do not have to be the same.
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Figure 22: Sample Name and Path for OII

4. Click Next. The Select Installation Type screen opens. 

Figure 23: Select Installation Type Screen
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5. Deselect “Insight OBIEE Component” and the “Insight ODI Component”. 

Figure 24: Deselect “Insight OBIEE Component” and “Insight ODI Component”

6. Click Next. The Database Configuration Parameters screen opens. 

Figure 25: Database Configuration Parameters Screen
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This screen allows you to connect to the Oracle database either by entering the information at the 
fields under Oracle JDBC Settings or by using a connect string.

Option 1: Specify the Oracle JDBC Settings:
Under the Oracle JDBC Settings, enter the following information at the fields:

• Host Name - Enter the host name of the Oracle database.

• SID or Service Name - Enter either the System Identifier or Service Name of the Oracle 
database (i.e. orcl).

• Port - Enter the Port number (the default is 1521).

Option 2: Enter a Custom Connect String:
a. Check the Custom Connect String box. A blank text box will appear on the screen.

Figure 26: Connect String Box

b. Enter the connect string in the text box using one of the following formats:
[HOST][:PORT]:SID

or

[HOST][:PORT]/SERVICE

Note In the second format SERVICE may be an oracle service name or a SID.
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For example:

hostname:1521:orcl

or

hostname:1521/orcl

Figure 27: Connect String using SID

7. Enter the User Name and Password to the Oracle database.

8. Select the Test Connection button to ensure that a connection to the Oracle database could be 
made with the information you provided. An error message will appear if the connection fails.

Figure 28: Connection to Database was Successful

Important Make sure that you use a user account that has SYSDBA privileges.
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9. Click Next. The Schema Configuration Parameters screen opens. This screen allows you to 
enter user names and password for the OII schemas. Note that when you arrive at this screen the 
default user names for the schemas (OII_ST, OII_WH, etc.) are already provided. These user 
names can be changed if you wish.

Figure 29: Schema Configuration Parameters Screen

10. Either keep the default user names or enter new ones for the OII schemas. 

11. Enter a password for each of the OII schemas. 

Important Make sure that you record all user names and passwords that you enter at this screen. 
You will need them later on in order to perform various post-installation configuration 
steps.
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12. Click Next. The Summary Screen opens.

Figure 30: Summary Screen

13. Review the summary settings and click Install to start the installation. The following screen 
appears and allows you to follow the progress of the installation.

Figure 31: Progress Screen
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When the installation is complete the Configuration Assistant screen opens. This screen displays 
the tools to be run prior to completing the installation.

In the event that any components failed the configuration process, it will display the details of the 
error on the lower portion of the screen.

Figure 32: Configuration Assistants Screen

14. In the event of an error, refer to the log files and fix the issue and then select Retry. 

15. If all tools run successfully, you will automatically proceed to the next screen which will 
announce that the OII installation has been successful.

WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step is to configure Oracle Application Express. Go to:
• .Chapter 6: Configuring Oracle Application Express
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Chapter 6

Configuring Oracle Application Express
Once APEX is installed you must create a Workspace for the Warehouse Palette using the 
Oracle Application Express Administration Service. 
This section will walk you through the steps for creating and configuring a workspace for the 
Warehouse Palette. For an in-depth description of the features of the APEX Administration 
Service, refer to these manuals: 

• Oracle Application Express Installation Guide 4.0

• Oracle Application Express Administration Guide Release 4.0

• Oracle Application Express Application Builder User’s Guide Release 4.0

These manuals can be found along with the rest of the APEX documentation set at:
http://www.oracle.com/technetwork/developer-tools/apex/documentation/index.html
The following are the high-level steps for creating and configuring a Workspace for the 
Warehouse Palette.

Table 1: Configuration Road Map

Step Description

Step 1 Create a Workspace for the Warehouse Palette

Step 2 Create a User for the Warehouse Palette Workspace

Step 3 Delete the Sample Application from the Warehouse Palette Workspace

Step 4 Import OII Application into APEX

Step 5 Open the Warehouse Palette

http://www.oracle.com/technetwork/developer-tools/apex/documentation/index.html
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STEP 1: CREATE A WORKSPACE FOR THE WAREHOUSE PALETTE
1. Enter the URL for the APEX Administration Service in your Web browser: 

 
http://<hostname>:<port>/apex/apex_admin

where:

hostname - the host name where the WebLogic application server is installed.

port - is the port number assigned to the WebLogic Application Server. The default port for the 
Oracle Application Express Listener deployed on WebLogic is 7001. If the WebLogic 
Application Server was configured on a different port, then this port should use that port.

apex - the mount point defined in the Web Server configuration file.

For example:
http://host_name:7001/apex/apex_admin

The APEX Administration Service Login screen will appear in your browser:

Figure 33: APEX Administration Service Login Screen

2. When the Login page comes up for the APEX Administration Services enter:

• Username - Enter admin.

• Password - Enter whatever ADMIN account password that you specified when you changed 
the default ADMIN password during the initial APEX installation. 

Note If you forget the password please refer to the Oracle Application Express Installation 
Guide for instructions on how to reset the password.
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The APEX Administration Services console opens.

Figure 34: APEX Administration Services Console

3. Click on the Manage Workspaces tab. The Manage Workspaces page opens.

Figure 35: Manage Workspaces Page
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4. Click on Create Workspaces under the Workspace Actions section. The Identify Workspace 
screen opens. This is the first screen in a wizard that will walk you through the steps of creating 
a workspace.

Figure 36: Identify Workspace Screen

5. For Identify Workspace:

• Workspace Name - Enter a Workspace Name for the Warehouse Palette  
(i.e., OII_WP)

• Workspace ID - Leave this field blank. It will be automatically generated by APEX. 

• Workspace Description - Enter a description of the workspace. The description is optional.
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6. Click Next. The Identify Schema page opens.

Figure 37: Identify Schema Screen

7. For Identify Schema:

• Re-Use existing schema? - Select Yes.

• Schema Name - Enter a schema name for the Warehouse Palette (i.e. OII_WP).

• Schema Password - There is no need to specify a password since you selected “Yes” at the 
Re-Use existing schema? prompt.

• Space Quota - Accept the default.

8. Click Next. The Identify Administrator screen opens.

Figure 38: Identify Administrator Screen
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9. For Identify Administrator:

• Administrator Username - Accept the default, ADMIN.

• Administrator Password - Enter a case-sensitive password of your choice. 
 
Note that the username/password that you enter here is different from the username/password 
that you used to log into the APEX Administration Services Console.

10. Enter the remaining information on this screen including your first and last name and your email 
address.

11. Click Next. The Confirm Request page opens.

Figure 39: Confirm Request Screen

Important Remember this username and password as well as the workspace name. You will need 
this information once you exit the APEX Administration Services Console and log back 
in.
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12. Review the information on this screen and click the Create Workspace button. The Success 
Confirmation page opens.

Figure 40: Success Confirmation Screen

13. Click Done. You will returned to the Manage Workspaces screen.

14. Click on the Logout link to exit the APEX Administrative Services console.
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15. Click on the Login button. This time you will be prompted for the Warehouse Palette workspace 
login information:

Figure 41: Login Screen for the Warehouse Palette Workspace

16. Enter the Workspace Name, Username, and Password for the Warehouse Palette workspace.

17. Click the Login button. This time a screen will appear and prompt you to change the workspace’s 
password:

Figure 42: Change Password for the Warehouse Palette

18. Change the Warehouse Palette workspace password:

a. Enter the current password.

b. Enter a new password.

c. Reenter the new password.

d. Click Apply Changes.
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A message will appear on the screen confirming that the password has changed. A single Return 
button will also appear on the screen.

19. Click the Return button. You will be returned to the Login screen.

Figure 43: Login Screen for the Warehouse Palette Workspace
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20. Enter the new password and click the Login button. The screen will open on the Warehouse 
Palette workspace.

Figure 44: The Warehouse Palette Workspace
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STEP 2: CREATE A USER FOR THE WAREHOUSE PALETTE 
WORKSPACE

1. Open the Administration menu and select Manage Users and Groups. The Users screen for 
the Warehouse Palette workspace opens.

Figure 45: Users Screen for the Warehouse Palette Workspace

2. Click the Create User button. The Create User page opens.

Figure 46: Create User Page
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3. Under User Identification, enter:

• Username - Enter the username that is used to log into the system.

• Email Address - Enter an email address for the user.

• First Name (optional) - Enter the user’s first name.

• Last Name (optional) - Enter the user’s last name.

• Description (optional) - Enter a description of the user (i.e, business analyst).

4. Under Account Privileges:

• Default Schema - The default schema is the schema you created for the workspace (see page 
41). 

• Accessible Schemas (null for all) - Leave this field blank.

• User is a workspace administrator - Select No.

• User is a developer - Select No.

• Application Builder Access - Determines whether a developer has access to the Application 
Builder. This option is greyed out if “No” is selected at User is a developer.

• SQL Workshop Access - Determines whether a developer has access to the SQL Workshop. 
This option is greyed out if “No” is selected at User is a developer.

• Team Development Access - Determines whether a developer has access to the Team 
Development.

• Set Account Availability - Select Locked to prevent the account from being used or 
Unlocked to allow the account to be used. 

5. Under Password:

• Password - Enter a password for the user.

• Confirm Password - Reenter the user password.

• Require Change of Password on First Use - Select No to allow the user to use the password 
until it expires. Select Yes to require the user to change the password upon the initial login.

6. Click the Create User button. You will be returned to the Users screen. The new user is listed on 
the screen.

Figure 47: The New User is Added to the Warehouse Palette Workspace
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STEP 3: DELETE THE SAMPLE APPLICATION FROM THE 
WAREHOUSE PALETTE WORKSPACE

APEX adds a sample application to each new workspace that is created. The sample application 
serves no purpose in the Warehouse Palette workspace and should be removed.

1. Log into APEX as an administrator.

2. Return to the Homes page for the Warehouse Palette workspace.

3. Select the Application Builder icon. The Application Builder page open. 

Figure 48: Sample Application

4. Click on the Sample Application. The page for the Sample Application opens.

Figure 49: Contents of the Sample Application
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5. Click on the Edit Application Properties. The Edit Application screen opens.

Figure 50: Sample Application Definitions.

6. Click on the Delete button. A message screen will appear asking you to confirm your decision.

Figure 51: Confirm Deletion of Sample Application

7. Click the Permanently Delete Now button.

8. You will be returned to the All Applications tab on the Application Builder screen. A message at 
the top of the screen will inform you that the Sample Application has been deleted.
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STEP 4: IMPORT OII WAREHOUSE PALETTE APPLICATION INTO 
APEX

1. On the Application Builder page, click on the Import button.

Figure 52: Import Button

The Specify File page opens:

Figure 53: Specify File Page

2. For the Specify File box, select the following:

• Import File - Use the Browse button to locate the wp_apex.sql file under the upgrade folder 
for OII 7.0.2: 
 
<Insight702Package>\install\apex\wp_apex.sql

For example:

C:\Insight702Package\install\apex\wp_apex.sql

• File Type - Select Database Application, Page or Component Export.

• File Character Set - Keep the File Character Set default.
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3. Click Next. The screen refreshes and message will inform you that the import was successful.

Figure 54: File Import Confirmed

4. Click Next. The Install Application screen opens.

Figure 55: Install Application

5. On the Install Application screen, select the following:

• Parsing Schema - Select the “OII_WP” schema.

• Build Status - Select “Run and Build Application”.

• Install as Application - The option allow you to avoid application ID conflicts. The 
application ID is part of the URL that is used to access the Warehouse Palette. For example:

http://hostname:7001/apex/f?p=101:1

There are three options listed here but you only need to select either:

• Reuse Application ID From Export File - An Application ID of 101 is automatically 
assigned to the Warehouse Palette during the OII installation. If you choose this option 
then 101 will be used as the application ID for Warehouse Palette as shown in the sample 
URL above.

• Auto Assign New Application ID - This option automatically assigns a unique 
application ID within APEX. If you select this option make note of the new application 
ID and include it in the URL. 
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6. Click Install. You will be returned to the Application Builder page. The newly installed 
Warehouse Palette application will appear on this page.

Figure 56: The Warehouse Palette has been Redeployed

STEP 5: OPEN THE WAREHOUSE PALETTE
1. Open you browser and enter the URL where the Warehouse Palette resides: 

 
http://<hostname>:<port>/apex/<application ID>

where:

• hostname - the name of the system where WebLogic is installed.

• port - is the port number assigned to the WebLogic application server. The default port is 
7001.

• apex - the mount point defined in the Web Server configuration file.

• application ID - the unique application ID assigned to the Warehouse Palette.

For example:

http://hostname:7001/apex/f?p=101:1

The Warehouse Palette login screen appears:

Figure 57: Warehouse Palette Login Screen

2. Use the ADMIN account’s user name and password that you created in Step 1: Create a 
Workspace for the Warehouse Palette on page 38.

Note The user account you use here must have Administrator privileges in order to access 
the Options feature within the Warehouse Palette.
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3. Click on the Login button. 

4. The Manage LOBs page opens. This screen is the home page of the Warehouse Palette.

Figure 58: Warehouse Palette Home Page

5. Click on Options to open the Options page.

Figure 59: Options Page

6. At the Web Service Host field enter the hostname and port in this format:

<hostname>:port

where:

• <hostname> - the name of the system where WebLogic is installed.

• port - is the port number assigned to the WebLogic application server. The default port is 
7001.

7. Click Apply Changes to save your change.

8. Select Logout to exit the Warehouse Palette.

Note The Options screen can only be modified by a user with Administrator privileges. For all 
other users, this screen is read-only.
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WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step in the installation process is to configure ODI. Go to:

• Chapter 7: Configuring Oracle Data Integrator
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Chapter 7

Configuring Oracle Data Integrator
This section provides the steps to create, configure, and import the Master and Work 
repositories for OII. 

STEP 1: IMPORT THE DATABASE .DMP FILE FOR OII
The upgrade package for OII 7.0.2 contains a single .DMP file, OII_ODI_MS_WK.DMP, 
which bundles the Master and Work schemas and repositories for OII. The 
OII_ODI_MS_WK.DMP file is located under: 
<702_PACKAGE>\install\odi
For example:
C:\Insight702Package\install\odi

1. Copy <702_PACKAGE>\install\odi\OII_ODI_MS_WK.DMP to the dpdump folder 
on the machine where the Oracle database is installed:

<$ORACLE_HOME>\admin\orcl\dpdump

For example:

C:\oracle\product\11.2.0\admin\orcl\dpdump

Table 2: Configuration Road Map

Step Description

Step 1 Import the Database .DMP File for OII

Step 2 Connect to the Master Repository

Step 3 Update the Connection Information to the Master and Work Repositories

Note The actual path will be different depending on where you installed the Oracle database.
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2. Use the following command to import the OII_ODI_MS_WK.DMP file 

3. Change the passwords to the Master and Work Schemas:

a. At the command line, start SQL*Plus and connect to the database as SYS, specifying the 
SYSDBA role. Use the net service name (Insight700) you created in Chapter 4: Creating a 
Database Connection to connect to the Oracle database. For example:

 
Information similar to the following output is displayed on the screen: 

b. Enter the appropriate password to connect to the database. The SQL> prompt will appear on 
the command line: 

c. Change the passwords to the Master and Work schemas using the following syntax. 

For example (Master schema):

For example (Work schema):

Note If you wish to supply your own schema name, use the following command:

impdp dumpfile=OII_ODI_MS_WK.DMP 
schemas=OII_ODI_MS,OII_ODI_WK remap_schema=OII_ODI_MS:<new 
master schema> remap_schema=OII_ODI_WK:<new work schema>

impdp dumpfile=OII_ODI_MS_WK.DMP schemas=OII_ODI_MS,OII_ODI_WK

sqlplus sys@Insight700 as sysdba 

> SQL*Plus: Release 11.2.0.1.0 Production on Fri Jan 14 15:29:19 2011

> Copyright (c) 1982, 2010, Oracle.  All rights reserved.

> Enter password: 

SQL>

ALTER USER <schema_name> IDENTIFIED BY <password>;

ALTER USER OII_ODI_MS IDENTIFIED BY oracle1;

ALTER USER OII_ODI_WK IDENTIFIED BY oracle1;
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STEP 2: CONNECT TO THE MASTER REPOSITORY
In this step you must use ODI Studio to connect to the Master and Work Repositories that you 
imported in the previous section.

1. Open ODI Studio:

Start>All Programs>Oracle>Oracle Data Integrator>ODI Studio

2. When run for the first time, ODI Studio prompts you for the location of Java JDK. Enter the path 
of the Java JDK under the Middleware Home directory as shown below:

Figure 60: Enter the Path of the Java JDK

3. Click OK. ODI Studio will open:

Figure 61: ODI Studio

Important The java.exe must be a 32-bit even if the machine that it is running on is 64-bit.



Chapter 7 – Configuring Oracle Data Integrator

60

4. Select File > New to open the New Gallery screen.

Figure 62: New Gallery Screen

5. In the Categories tree on the left, select ODI and then select Create a New ODI Repository 
Login from the Items list.
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6. Click OK. The Repository Connection Information dialog box appears. This dialog box 
contains the ODI User, the Master Schema User, and Work Repository name for a given ODI 
environment.

Figure 63: Repository Connection Information Screen

7. Specify the Oracle Data Integrator Connection details: 

• Login name: A name used to connect to the Master Repository and then to create the Work 
Repository. It can be any name that you choose (the example on the next page uses OII7 as 
the login name).

• User: SUPERVISOR

• Password: SUNOPSIS

Note Use UPPERCASE for the User and Password just as they appear above.
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8. Specify the Database Connection (Master Repository) details: 

• User: The same user name (e.g., OII_ODI_MS) that you specified when you created the 
schema for the Master Repository in Step 1: Import the Database .DMP File for OII on page 
57. 

• Password: The same password (e.g., oracle1) that you specified when you created the 
schema for the Master Repository in Step 1: Import the Database .DMP File for OII on page 
57. 

• Driver List: Select “Oracle JDBC Driver” from the drop-down list. 

• Driver Name: This field will be automatically filled out based upon the Driver List. In this 
case the driver name is “oracle.jdbc.OracleDriver”.

• URL: The URL used to establish the JDBC connection to the database hosting the repository: 
(i.e. jdbc:oracle:thin:@<host>:<port>:<sid> ).

Figure 64: Connection Information for the Master Repository
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9. Under the Work Repository section select the Master Repository Only radio button.

10. Click Test to validate your entries. The following dialog box should appear to indicate that the 
connection was successful. If you receive an error message, review the connection information 
and confirm that the connection information you entered was correct.

Figure 65: Connection to the Master Repository was Successful

11. Click OK to close this message box.

12. On the Repository Connection Information window, click OK to close the window.

13. Select ODI>Connect. The Oracle Data Integrator Login window will open.

Figure 66: Oracle Data Integrator Login Window

14. Select the Login Name to the Master Repository that you created in the previous step (e.g., OII7) 
from the drop-down list and click OK. A series of messages will appear in a dialog box on the 
screen as you are connected to the Master Repository.
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15. Once connected, open the Topology Navigator by selecting View>ODI Topology Navigator.

Figure 67: ODI Topology Navigator

16. Click on the Repositories panel to display the Master and Work Repository. 

Figure 68: Master and Work Repository
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17. Click on the Work Repositories node to confirm that the “DEV” Work Repository is present. 

Figure 69: “DEV” Work Repository

STEP 3: UPDATE THE CONNECTION INFORMATION TO THE 
REPOSITORIES

The next step is to update the connection information stored there to point to you own 
environment.
1. In the Topology Navigator (View>ODI Topology Navigator) click on the Physical 

Architecture panel.

Figure 70: Physical Architecture Panel

2. Expand the Technologies node and scroll down to the Oracle node.
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3. Expand the Oracle node to display the ORACLE_OII node.

Figure 71: ORACLE_OII

4. Double-click on ORACLE_OII. The Data Server dialog box for ORACLE_OII will appear 
on the right.

Figure 72: Data Server for ORACLE_OII

5. Update the user name and password with your OII_SYS user name and password. This is the 
same user name and password that you entered on the Schema Configuration Parameters 
screen (see page 33) during the OII installation.
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6. Click on the JDBC item to open the JDBC screen.

Figure 73: JDBC Screen for ORACLE_OII

7. Update the information on the JDBC screen.

8. Click on the Test Connection button at the top of the JDBC screen to test the updated connection 
information. The following dialog box opens:

Figure 74: Test Connection Dialog Box

9. Click the Test button. The following dialog box should appear to indicate that the connection was 
successful. If you receive an error message, return to the Data Server and JDBC screen and 
confirm that the connection information you entered was correct.

Figure 75: Connection to the Master Repository was Successful
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10. Expand the ORACLE_OII node. You will see all physical schemas attached to this data server. 
There are four listed there: OII_DM, OII_WH, OII_ST and OII_SYS. 

Figure 76: Schemas for Oracle_OII

11. Separately double-click on each schema to open the Physical Schema screen.

Figure 77: Physical Schema for OII_DM

12. Confirm that each schema has the Work Schema set to OII_WRK.

Figure 78: Work Schemas Must be Set to OII_WRK

13. Once you have reviewed the information for all of the schemas, select Save from the File menu 
or tool bar to save any changes.
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14. Under the Work Repositories node double-click on Dev.

Figure 79: Double-Click “Dev”

The following settings screen for DEV will open in the right pane:

Figure 80: Settings Pane for DEV

15. Click on the Connection icon in the upper left of the pane to connect to the Work Repository.

Figure 81: Select the Connection Icon



Chapter 7 – Configuring Oracle Data Integrator

70

The Data Server screen for the Work Repository opens in the right pane:

Figure 82: Data Server Screen

16. Update the user/password so they correspond to the user/password that you specified for the 
Work schema (e.g, OII_ODI_WK/oracle1) in Step 1: Import the Database .DMP File for OII on 
page 57.

17. Click on the JDBC tab to open the JDBC screen.

Figure 83: JDBC Screen

18. Update the JDBC URL used to establish the JDBC connection to the database.
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19. Click the Test Connection button at the upper left of the screen. The following Test Connection 
box appears:

Figure 84: Test Connection Dialog Box

20. Click Test to validate your entries. The following dialog box should appear to indicate that the 
connection was successful. If you receive an error message, return to the Data Server and JDBC 
screen and confirm that the connection information you entered was correct.:

Figure 85: Connection was Successful

21. Click OK to close this message box.

22. Select Save from the File menu or tool bar to save your changes.

23. Select ODI>Disconnect to disconnect from the Master Repository.

24. Select ODI>Connect to open the Oracle Data Integrator Login window.

25. Select the login name for the Master Repository and click on the Edit button.

Figure 86: Select the Edit Button
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26. When the Repository Connection Information window opens select the Work Repository 
radio button.

Figure 87: Select the Work Repository Radio Button
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27. Click on the Search button on the right. The Select Repository window will appear. 

Figure 88: Select DEV

28. Select “DEV” and click OK. “DEV” will now appear in the Work Repository field back on the 
Repository Connection Information window.

Figure 89: DEV in the Work Repository Field

29. Click Test to validate your entries. A message box will appear to indicate the connection has been 
successful:

Figure 90: Connection was Successful

30. Click File>Exit to close ODI Studio.
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WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step in the installation process is to run the upgrade utility for OII 7.0.2. For these steps, go 
to:

• Chapter 8: Running the OII 7.0.2 Upgrade Utility
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Chapter 8

Running the OII 7.0.2 Upgrade Utility

STEP 1: EDIT THE APPLICATION.PROPERTIES FILE
1. Open the <Insight702Package>\application.properties file.

For example: C:\Insight702Package\application.properties

Figure 91: The <Insight702Package>\application.properties File



Chapter 8 – Running the OII 7.0.2 Upgrade Utility

76

2. Update the corresponding parameters for your system.

Figure 92: Contents of the application.properties File

3. Save and close the <Insight702Package>\application.properties file. 

STEP 2: RUN THE OII 7.0.2 UPGRADE UTILITY
1. Open a command prompt window.

2. Run the upgrade utility: <Insight702Package>\upgrade.bat

For example: C:\Insight702Package\upgrade.bat

Once executed you will be prompted for a series of password. These are the same passwords that 
you entered on the Schema Configuration Parameters screen on page 33.
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3. Follow the prompts on the screen and supply the proper passwords as required.

Figure 93: Running the Upgrade Utility on Windows

WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step in the installation process is to setup the security credentials for the ODI Wrapper 
Service. For these steps, go to:

• Chapter 9: Setting Up Security Credentials for the ODI Wrapper Service
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Chapter 9

Setting Up Security Credentials for the ODI 
Wrapper Service
This chapter describes how to setup the security credentials for the ODI Wrapper Service. 

STEP 1: EDIT THE CSUTIL.PROPERTIES FILE
1. Go to the <OII_ROOT>\app\csutil\config\ directory and locate the csutil.properties file.

For example: 
 
C:\Oracle\Insight_Home\Insurance\oii\7.0.0\app\csutil\config\csutil.properties

2. Open csutil.properties in a text editor. This file contains a single line showing the full path to 
the jps-config-jse.xml file. For example:

CredentialStoreConfig=C:\\Oracle\\Middleware\\user_projects\\domains\\
<domain_name>\\config\\fmwconfig\\jps-config-jse.xml

3. Replace <domain_name> in this line with the actual name of the domain that you will be using.

For example:

CredentialStoreConfig=C:\\Oracle\\Middleware\\user_projects\\domains\\
oii_domain\\config\\fmwconfig\\jps-config-jse.xml

4. Save and close the csutil properties file.

Note Throughout this chapter we will be referring to the directory structure created during the 
OII installation. For the sake of consistency this section will refer to the default OII 
installation directory as <OII_Root>. For example:
C:\Oracle\Insight_Home\Insurance\oii\7.0.0

Note The example above shows the default name and location of the Middleware home 
directory (i.e., C:\Oracle\Middleware) as it appears in the csutil.properties file. 
If you specified different locations for the Middleware home directory when you installed 
OBIEE 11g, please use those directories instead of the default ones presented in the 
csutil.properties file.

Note In windows you must keep the double forward backslashes (\\).
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STEP 2: ADD SECURITY CREDENTIALS
Once you have updated csutil.properties you will need to run the add.bat command three times at 
the command line in order to add the security credentials for each of the following key names:
• ODIUSER
• SYSUSER
• WPUSER

When you run add.bat you will be prompted for a key name, user name and password. The required 
user name and password combinations for each ley name are shown in the table below.

To add the security credentials:

1. Open a command prompt and go to: <OII_Root>app\csutil\bin 

For example:  
 
C:\Oracle\Insight_Home\Insurance\oii\7.0.0\app\csutil\bin 

2. At the command line, type add and press Enter. You will be prompted for a key name: 

3. For ODIUSER, type in the key name, user name, and password from the table on the previous 
page. Press Enter after each entry. A message will confirm that the security credential for 
ODIUSER has been added. For example: 

key name user name password

ODIUSER SUPERVISOR SUNOPSIS

SYSUSER OII_SYS The corresponding password you entered for OII_SYS on the 
Schema Configuration Parameters screen during the OII 
installation (see Chapter 5: Installing OII 7.0 on page 33).

WPUSER OII_WP The corresponding password you entered for OII_WP on the 
Schema Configuration Parameters screen during the OII 
installation (see Chapter 5: Installing OII 7.0 on page 33).

Note You may have entered different user names during the OII installation but the user names in 
the table above are based on the assumption that you accepted the user name defaults on 
the Schema Configuration Parameters screen during the OII installation. 

Enter key: 

Enter key: ODIUSER
Enter username: SUPERVISOR
Enter password: SUNOPSIS
Credential added: ODIUSER
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4. For SYSUSER, run the add command again and enter the information from the table on the 
previous page for SYSUSER when prompted. For example: 

5. For WPUSER, run the add command a third time and enter the information from the table on the 
previous page for WPUSER when prompted. For example: 

WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step in the installation process is to setup the security credentials for the Warehouse Palette 
Agent. Go to:
• .Chapter 10: Setting Up Security Credentials for the Warehouse Palette Agent

Note The <OII_Root>app\csutil\bin directory also contains a readme.txt file which lists a 
series of batch file commands for adding, deleting, updating, and testing security 
credentials. You can refer to them as needed. For example, if you come across an 
existing key, you can run the update command describe in the readme file to update the 
credential.

Enter key: SYSUSER
Enter username: OII_SYS
Enter password: 
Credential added: SYSUSER

Enter key: WPUSER
Enter username: OII_WP
Enter password: 
Credential added: WPUSER
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Chapter 10

Setting Up Security Credentials for the 
Warehouse Palette Agent
The Warehouse Palette Agent serves as the conduit between the Warehouse Palette and the OII 
system. It allows a Line of Business (LOB) that is created in the Warehouse Palette to be “published/
unpublished” to OII.
This chapter describes how to:

• edit the properties file to setup the security credentials for the Warehouse Palette Agent

• test and run the Warehouse Palette Agent 

For further information on the Warehouse Palette, refer to the Oracle Insurance Insight Warehouse 
Palette User Guide.

STEP 1: EDIT THE AGENT.PROPERTIES FILE
1. Go to the <OII_ROOT>\app\agent\config\ directory and locate the agent.properties file.

For example: 
 
C:\Oracle\Insight_Home\Insurance\oii\7.0.0\app\agent\config\agent.properties 

2. Open agent.properties in a text editor. This file contains these lines: 

CredentialStoreConfig=C:\\Oracle\\Middleware\\user_projects\\domains\\
<domain_name>\\config\\fmwconfig\\jps-config-jse.xml

JdbcUrl=jdbc:oracle:thin:@<host>:<port>:<sid>

Important The Warehouse Palette Agent must be running in order to process a request to  
publish/unpublish a LOB.

Note For the instructions on scheduling the Warehouse Palette Agent, refer to Appendix A: 
Scheduling the Warehouse Palette Agent.
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3. In the first line, replace <domain_name> with the name of the WebLogic domain that you are 
using. 

For example:

CredentialStoreConfig=C:\\Oracle\\Middleware\\user_projects\\domains\\
oii_domain\\config\\fmwconfig\\jps-config-jse.xml

4. On the next line, enter the applicable <host>, <port>, and <sid> for the Oracle database.

JdbcUrl=jdbc:oracle:thin:@<host>:<port>:<sid>

For example:

JdbcUrl=jdbc:oracle:thin:@hostname:1521:orcl

5. Save and close the agent.properties file.

STEP 2: TEST THE WAREHOUSE PALETTE AGENT
1. Open a command prompt and go to: <OII_ROOT>\app\agent\bin

For example: C:\Oracle\Insight_Home\Insurance\oii\7.0.0\app\agent\bin

2. At the command prompt type: agent_status

Note The example above shows the default name and location of the Middleware home 
directory (i.e., C:\Oracle\Middleware) as it appears in the agent.properties file. 
If you specified different locations for the Middleware home directory when you installed 
OBIEE 11g, please use those directories instead of the default ones presented in the 
agent.properties file.

Note On windows you must keep the double-forward backslashes (\\).
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This command will show the status of all LOBs in the Warehouse Palette. If there is a 
connection problem a message will appear identifying the problem. Refer to the OII Warehouse 
Palette User Guide for more information on connection error messages and their solutions.

Figure 94: The agent_status Command Displays the Status of each LOB

STEP 3: START THE WAREHOUSE PALETTE AGENT
1. Open a command prompt and go to: <OII_ROOT>\app\agent\bin

For example: C:\Oracle\Insight_Home\Insurance\oii\7.0.0\app\agent\bin

2. Start the agent by typing: agent_start

3. A series of messages will appear in the command line as the Warehouse Palette Agent starts and 
connects to the server.

STOPPING THE WAREHOUSE PALETTE AGENT
1. To stop the Warehouse Palette Agent, open a new window and at the command prompt and go 

to: <OII_ROOT>\app\agent\bin

For example: C:\Oracle\Insight_Home\Insurance\oii\7.0.0\app\agent\bin

2. Start the Warehouse Palette Agent by typing: agent_stop

Important The Warehouse Palette Agent must be running in order to publish/unpublish a 
LOB.
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WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step in the installation process is to perform a series of configuration tasks in ODI. For these 
tasks, go to: 
• Chapter 11: Configuring OBIEE 11g
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Chapter 11

Configuring OBIEE 11g
This chapter describes the steps to configure OBIEE 11g.

STEP 1: DEPLOY THE OII 7.0.2 REPOSITORY
Follow the steps in this section to deploy the Insight_702.rpd to OBIEE.

SUB-STEP A: COPY THE OII 7.0.2 REPOSITORY FILE TO OBIEE
1. Locate the OII 7.0.2 repository file for OBIEE, Insight_702.rpd, under:

<Insight702Package>\install\obiee\repo\Insight_702.rpd 
For example:
C:\Insight702Package\install\obiee\repo\Insight_702.rpd 

Figure 95: The OII 7.0.2 Repository File for OBIEE
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2. Copy Insight_702.rpd to the repository folder under:
<MW_HOME>\instances\<instance#>\<domain_name>\OracleBIServerComponent\
coreapplication_obips1\repository

For example:
C:\Oracle\Middleware\instances\instance1\bifoundation\OracleBIServerComponent\
coreapplication_obips1\repository

SUB-STEP B: CREATE THE INSIGHT_7 FOLDER
1. Create an empty folder named Insight_7 under 
<MW_HOME>\instances\<instance#>\<domain_name>\OracleBIPresentationServicesComponent\ 
coreapplication_obips1\catalog

For example:
C:\Oracle\Middleware\instances\instance1\<domain_name>\OracleBIPresentationServicesComponent\ 
coreapplication_obips1\catalog
The full path to with the Insight_7 folder will now appear as:
C:\Oracle\Middleware\instances\instance1\<domain_name>\OracleBIPresentationServicesComponent\ 
coreapplication_obips1\catalog\Insight_7

SUB-STEP C: DEPLOY THE OII REPOSITORY
1. Log into Enterprise Manager (see Opening the Oracle Fusion Middleware Control on page 12 in 

Chapter 3: Installing the Prerequisite Software for OII). The Oracle Fusion Middleware Console 
will open.

Figure 96: Oracle Fusion Middleware Console

2. From the navigation tree on the left, select Farm_<domain_name>Business Intelligence> 
coreapplication. 
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3. In the screen on the left, click on the Deployment tab and then select the Repository tab. The 
following screen opens:

Figure 97: Repository Tab

4. Click on the Lock and Edit Configuration button on the top to lock the current domain for 
editing.

Figure 98: Lock and Edit Configuration Button

5. Under the Upload BI Server Repository section, click on the Browse button and locate the 
Insight_702.rpd repository file. This is the same repository file that you copied to the OBIEE 
Server repository directory in Step 1: Deploy the OII 7.0.2 Repository on page 87.

For example:
C:\Oracle\Middleware\instances\instance1\<domain_name>\OracleBIServerComponent\
coreapplication_obips1\repository
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6. Once you have uploaded the file, enter the following default repository password, twice: 
 
welcome1

Figure 99: Enter the Repository Password

7. Under the BI Presentation Catalog section, enter the full path to the Insight_7 catalog folder in 
the Catalog Location field that you created in Sub-step B: Create the Insight_7 Folder on page 
88. The full path to the Insight_7 folder is:

<MW_HOME>\instances\<instance#>\<domain_name>\OracleBIPresentationServicesComponent\ 
coreapplication_obips1\catalog\Insight_7

For example:
C:\Oracle\Middleware\instances\instance1\<domain_name>\OracleBIPresentationServicesComponent\ 
coreapplication_obips1\catalog\Insight_7

8. Click on the Apply button in the BI Server Repository section to save the changes.

Figure 100: Select Apply Button

At this point, the RPD is assigned a sequence number after it, and it is displayed as the current default 
online repository for the Oracle BI Domain (e.g., Insight_702_BI0003).

Figure 101: The RPD is Assigned a Sequence Number
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9. Select the Activate Changes button on top.

Figure 102: Select the Activate Changes Button

10. Click on the Capacity Management tab and then the Availability tab.

11. Click on the Restart All button to restart the services. A dialog box will appear and ask you to 
confirm your action to restart the services.

Figure 103: Select the “Restart All” Button

12. Click the Yes button in the dialog box to proceed with the restart. A message will appear to 
confirm that all services have restarted.
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STEP 2: UPDATE THE CONNECTION INFORMATION TO THE OII 
REPOSITORY

Update the OII repository connection information for the OII Subject Areas.

SUB-STEP A: OPEN THE OBIEE REPOSITORY FOR OII
1. Open the OBIEE Repository Administration Tool by selecting:

Start>All Programs>Oracle Business Intelligence>Administration

2. When the Administration Tool opens, select File>Open>Online to display the Online 
Repository dialog box.

3. In the login dialog box that appears, enter the repository password (the default password is 
welcome1) and click on OK.

4. Enter a valid user name and password. The default user name is weblogic and whatever password 
you selected when you installed OBIEE.

The following Repository screen will open:

Figure 104: Layers of the OBIEE Repository for OII
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SUB-STEP B: UPDATE THE “LINE OF BUSINESS” SUBJECT AREAS
1. Go to the Physical Layer pane.  

 
This pane contains the Subject Areas for each Line of Business (Commercial Auto, Homeowners, 
etc.) and an additional Subject Area called Insight700Config. You will need to configure the 
settings under each of the Line of Business Subject Areas and the Insight700Config Subject 
Area.

2. Expand each of the Line of Business Subject Areas under the Physical Layer pane. The 
Connection Pool icon will appear underneath each Subject Area:

Figure 105: Subject Areas under the Physical Layer
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3. Starting with the Commercial Auto Subject Area, click on the Connection Pool icon.

Figure 106: Connection Pool Icon

4. A message box will appear and ask you if you want to check out the Connection Pool.

5. Select Yes. The Connection Pool screen opens:

Figure 107: “Commercial Auto” Connection Pool Screen
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6. Make sure that the Require fully qualified table names option is unchecked. 

7. Under the “Shared Login” section, enter the same user name and password that you entered on 
the Schema Configuration Parameters screen for the Data Mart Schema (see page 33 in 
Chapter 5: Installing OII 7.0).

Figure 108: Data Mart Schema User Name and Password on the Schema Configuration Parameters Screen

8. Leave all of the other settings as is and click OK to close the screen.

9. Repeat steps 1-8 for each of the remaining Line of Business Subject Areas.

Note The default user name is OII_DM. If you entered a different user name on the Schema 
Configuration Parameters screen, use that name here.
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SUB-STEP C: CONFIGURE THE INSIGHT700CONFIG SUBJECT AREA
1. Click on the Connection Pool under the Insight700Config Subject Area to open the Connection 

Pool window.

Figure 109: Insight700Config Connection Pool Window

2. Make sure the data source name is Insight700Config.

3. Make sure that the Require fully qualified table names option is unchecked. 
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4. Under the “Shared Login” section, enter the same user name and password that you entered on 
the Schema Configuration Parameters screen for the System Configuration Schema (see page 
33 in Chapter 5: Installing OII 7.0).

Figure 110: System Configuration Schema User Name and Password on the Schema Configuration Parameters Screen

5. Click OK to close the screen.

6. Check in all the changes by selecting the Check-in button at the top of the tool bar:

7. Click the Save button.

8. Click the Close and Exit buttons to exit the OBIEE Administration Tool.

Note The default user name is OII_SYS. If you entered a different user name on the Schema 
Configuration Parameters screen, use that name here.
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STEP 3: CONFIGURE SECURITY SETTINGS FOR OII (OPTIONAL)
The OII system administrator can assign one or more of the following OII application roles to an OII 
user. The assigned role(s) determines which OII reports will be available to the users when they log 
into OBIEE. 

• Actuary

• Claims Management

• Executive

• Production

• Underwriting

If you wish to assign individual roles to users, use the Oracle Fusion Middleware Control to create 
and configure the necessary OII application roles, security groups, and user accounts to ensure that 
OII users are granted access to the proper data within OBIEE. Refer to the OII System Administration 
Guide for the complete instructions on configuring the security settings for OII.
If you do not wish to assign individual roles to a user, you can skip this step and use the default 
OBIEE login (welcome/weblogic1) or any user with administrative privileges to log into OBIEE. Any 
user with administrative privileges will have access to all of the OII reports.

STEP 4: DEPLOY THE OII CATALOG AND SYSTEM FILES
Follow the steps in this section to deploy the OII catalog files.

1. Open a new browser window and enter the following URL: 
 
http://<hostname>:<port>/analytics 

Note Refer to the OII User’s Guide for a specific description of the OII reports availabe to each 
application role.

Note In the above URL:

• <hostname> - is the server name or IP address where you installed OBIEE 

• <port> - is the port assigned to OBIEE. The default port will be different 
depending on whether or not you selected a “Simple” or “Enterprise” Install for 
OBIEE.

• Simple Install - the default port is 7001.

• Enterprise Install - the default port is 9704 but the user has the option to 
specify ports during the installation.
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The OBIEE front-end login screen similar to this one will appear.

Figure 111: Oracle Business Intelligence Login Screen

2. Login using the default User ID and Password (weblogic/welcome1) or any user account with 
administrator priveleges.

The default OBIEE home page appears.

Figure 112: OBIEE Default Home Page
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3. Select the Catalog button on the top bar.

Figure 113: Select the Catalog Button

The Catalog page opens:

Figure 114: Catalog Page

4. Click on Shared Folders in the top of the left pane.

5. Click on Unarchive in the bottom of the left pane. The Unarchive dialog box opens.

Figure 115: Unarchive Dialog Box

6. Select the Browse button to locate the.catalog folder under the OII 7.0.2 upgrade package:

<Insight702Package>\install\obiee\catalog

For example: 

C:\Insight702Package\install\obiee\catalog
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This folder contains the following catalog files:

Figure 116: Catalog Files in <Insight702Package>\install\obiee\catalog

7. Select the first catalog file in the list (e.g., Commercial Auto.catalog) and click the Open button. 
The File Upload dialog box will close and the Commercial Auto.catalog file will appear in the 
Archive file field in the Unarchive box.

8. Select the following options in the Unarchive box:

• Replace - Select All.

• ACL - Select Preserve.

Figure 117: Unarchive Box with Selected Catalog file

9. Click OK.

10. Repeat steps 6-10 for the remaining catalog files.
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11. Logout of OBIEE.

12. Go to the <Insight702Package>\install\obiee\catalog folder and copy the system folder to (this 
action will overwrite the system folder in the path below):

<MW_HOME>\instances\<instance#>\<domain_name>\OracleBIPresentationServicesComponent\
coreapplication_obips1\catalog\Insight_7\root\system
For example:
C:\Oracle\Middleware\\instances\instance1\<domain_name>\OracleBIPresentationServicesComponent\ 
coreapplication_obips1\catalog\Insight_7\root\system

13. Log back into OBIEE and verify that all OII Scorecard and Analysis Dashboards as well as all 
OII Reports are present as well as all system level default data formats.

Figure 118: OII Scorecard and Analysis Dashboards

Figure 119: OII Executive Reports
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STEP 5: DEPLOY THE METADATA DICTIONARY
Follow the instructions in this section to deploy the OII MetaData Dictionary.

SUB-STEP A: DEPLOY THE ANALYTICSRES FOLDER
1. Locate the analyticsRes folder at: 
<MW_HOME>\instances\<instance #>\<domain_name>\OracleBIPresentationServicesComponent\
coreapplication_obips1\analyticsRes

For example:
C:\Oracle\Middleware\instances\instance1\<domain_name>\OracleBIPresentationServicesComponent\
coreapplication_obips1\analyticsRes

2. Copy the analyticsRes folder to your Middleware home directory: <MW_HOME>

For example: C:\Oracle\Middleware

The folder, analyticsRes, now rests at the base of your Middleware home directory. For example:

C:\Oracle\Middleware\analyticsRes

3. Log into the Oracle WebLogic Server Administration Console (see Opening the Oracle 
WebLogic Server Administration Console on page 13 in Chapter 3: Installing the Prerequisite 
Software for OII).

Figure 120: WebLogic Server Administration Console
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4. Click on the Deployments link in the Domain Structure pane. The Summary of Deployments 
screen will open. 

Figure 121: Summary of Deployments Screen

5. Click the Lock & Edit button in the Change Center section in the left pane. 

6. Click the Install button on the Deployments table. The Install Application Assistant screen will 
open.

7. In the Path: box, enter the path to the <MW_HOME> (e.g., C:\Oracle\Middleware) directory 
where you copied the analyticsRes folder. 

Figure 122: Enter the path to <MW_Home>



Sub-step A: Deploy the analyticsRes Folder

105

8. The screen will refresh and a radio button for analyticsRes will appear on the screen.

Figure 123: analytics Res

9. Select the analyticsRes radio button and click Next.  The following screen appears:

Figure 124: Accept the Default Targeting Style



Chapter 11 – Configuring OBIEE 11g

106

10. Accept the default settings on this screen and click Next. The following screen appears. 

Figure 125: Deploy the analyticsRes Application

11. Go down to the “Source Accessibility” section of the screen and select:

I will make the deployment accessible from the following location

12. Click Finish. 
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13. Click the Activate Changes button in the Change Center section on the left pane.

Figure 126: Select “Activate Changes” Button

14. You will be returned to the Summary of Deployments screen where you will see the analyticsRes 
application deployed. 

15. If the analyticsRes application is not “Active” then start it by first selecting analyticsRes and 
then clicking the Start>Servicing all requests. 

Figure 127: Start the AnalyticsRes Application

16. If the deployment was successful, the “State” column corresponding to analyticsRes application 
should show “Active” and the “Health” column should show “OK”. 
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SUB-STEP B: EDIT THE INSTANCECONFIG.XML FILE
1. Open the instanceconfig.xml file located at:
<MW_HOME>\instances\<instance#>\config\OracleBIPresentationServicesComponent\
coreapplication_obips1\instanceconfig.xml

For example:
C:\Oracle\Middleware\instances\instance1\config\OracleBIPresentationServicesComponent\
coreapplication_obips1\instanceconfig.xml

2. Before the </ServerInstance> tag, add the following entry

<SubjectAreaMetadata>
<DictionaryURLPrefix>/analyticsRes/</DictionaryURLPrefix>
</SubjectAreaMetadata>

3. Save and close the file.

SUB-STEP C: COPY THE INSIGHT_702 FOLDER
1. Open the following folder under the 7.0.2 upgrade folder:

<Insight702Package>\install\obiee\metadata_dic 

For example: 

C:\Insight702Package\install\obiee\metadata_dic

2. You will see a single folder called Insight_702.

3. Copy the entire Insight_702 folder to:

<MW_HOME>\analyticsRes

For example:

C:\Oracle\Middleware\analyticsRes

The folder, Insight_702, now rests at the base of the analyticsRes folder. For example:

C:\Oracle\Middleware\analyticsRes\Insight_702

Important Once the copy is complete, go into the Insight_702 folder and make sure you have at 
least 36,000 files and over 1600 folders in total for this folder. If not extracted properly, 
some files may become lost during the transfer due to the long path/file name.
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4. :Rename the Insight_702 folder to match the name of the repository file you deployed in Sub-
step C: Deploy the OII Repository on page 88 (e.g., Insight_702_BI0003).

Figure 128: Rename the Insight_702 Folder to Match the Deployed Repository File

For example:
C:\Oracle\Middleware\analyticsRes\Insight_702_B10003

5. Log back into Enterprise Manager (see Opening the Oracle Fusion Middleware Control on page 
12 in Chapter 3: Installing the Prerequisite Software for OII). 

6. From the navigation tree on the left, expand Farm_<domain_name>Business Intelligence> 
coreapplication. 

7. Select the Capacity Management tab in the screen on the right.

8. Select the Restart All button.
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SUB-STEP D: TEST THE METADATA DICTIONARY OBIEE
1. Log into OBIEE (refer to the instructions on page 98).

2. From the lower menu, click New. The following list of options opens.

Figure 129: List of Available Options

3. Select Analysis. A list of OII Subject Areas opens.

Figure 130: Select Subject Areas
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4. Click on a Subject Area. The Analysis Editor opens.

Figure 131: Analysis Editor

5. In the Subject Areas pane on the left click on either the name of the subject area, the Metrics 
folder, or the name of a Filters folder.

6. Click on the Metadata Dictionary button in the upper right of the Subject Areas pane. 

Figure 132: Select the Metadata Dictionary Button
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The OII MetaData Dictionary will open in a separate browser screen. This screen will show details 
whatever item you selected in the Subject Area pane. The example below shows data for the Metrics 
folder.

Figure 133: OII MetaData Dictionary

WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step is to configure and deploy the ODI wrapper service by performing the steps described 
in:

• Chapter 12: Configuring and Deploying the ODI Wrapper Service

Note Refer to the OII User’s Guide for further information about viewing information in the OII 
MetaData Dictionary.
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Chapter 12

Configuring and Deploying the ODI WRAPPER 
SERVICE

In order for the Warehouse Palette to function properly the user needs to configure and deploy the 
ODI Wrapper Service within WebLogic.

STEP 1: DEPLOY THE ODI WRAPPER SERVICE EAR FILE
1. Open the WebLogic Administration Console (see Opening the Oracle WebLogic Server 

Administration Console on page 13 in Chapter 3: Installing the Prerequisite Software for OII).

Figure 134: WebLogic Server Administration Console

2. Click the Lock & Edit button in the Change Center section in the left pane. 
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3. Click the Deployments link under the Domain Structure pane. The Deployments screen will 
open.

Figure 135: Deployments Screen

4. Click the Install button. The Install Application Assistant screen will open.

Figure 136: Install Application Assistant Screen
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5. In the Path: box, enter the full path to the OdiWrapperService.ear file that is located under the 
upgrade folder for OII 7.0.2:  
 
<Insight702Package>\install\wrapper\OdiWrapperService.ear

For example:

C:\Insight702Package\install\wrapper\OdiWrapperService.ear

6. Click the Next button. The screen will refresh and a radio button for the OdiWrapperService.ear 
file will appear on the screen.

Figure 137: Select OdiWrapperService.ear

7. Select the OdiWrapperService.ear radio button.

8. Click the Next button. The following screen will open. 

Figure 138: Choose Targeting Style
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9. Select: Install this deployment as an application 

10. Click Next. The following screen opens:

Figure 139: Optional Settings Screen
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11. Scroll down to the “Source Accessibility” section of the screen and select:  
 
Copy this application onto every target for me

Figure 140: Source Accessibility Section

12. Leave the other default settings on this screen and click the Finish button. After the 
OdiWrapperService.ear file has been deployed, you will be returned to the Summary of 
Deployments. The OdiWrapperService.ear file will be listed. 

Figure 141: OdiWrapperService.ear File is Successfully Deployed

13. Click the Activate Changes button in the Change Center section on the left pane.
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14. To start the service, check OdiWrapperService.ear in the Deployments table and then click 
Start>Servicing all requests. 

Figure 142: Start the ODIWrapperService

STEP 2: CREATE A JDBC DATA SOURCE
1. If you have not already done so, click the Lock & Edit button in the Change Center section in 

the left pane. 

2. On the WebLogic Server Administration Console home page, select Services>JDBC>Data 
Sources. 

Figure 143: Select Services>Data Sources
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The Data Sources screen opens.

Figure 144: Create New Data Source

3. Click on the New button and select “Generic Data Source” from the drop-down list. The following 
screen opens.

Figure 145: Enter JDBC Data Source Properties
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4. In the JDBC Data Source Properties screen specify the following:

• Name - In the Name field, enter a user-defined name for the JDBC data source (e.g. ODI Data 
Source).

• JNDI Name - Give the connection the following name: jdbc/OdiDB

• Database Type - Select Oracle.

5. Click Next. The following screen opens:

Figure 146: Select Database Driver

6. From the Database Driver drop-down list select:

Oracle's Driver (Thin) for Service connections; Versions:9.0.1, 9.2.0, 10.11
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7. Click Next. The Transactions Options screen will open. The contents of this screen will be 
different depending upon which database driver that you selected on the previous screen. 

Figure 147: Select Transaction Options
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8. Accept the defaults on this screen and click Next. The following screen opens:

Figure 148: Select the Connection Properties

9. In the Connection Properties screen, enter the following:

• Database Name - Enter the Oracle SID (e.g. orcl).

• Host Name - Enter the machine name of the database (this is the name of the machine on 
which the ODI Master Repository database schema has been created).

• Port - Enter the port number used to access the database (e.g. 1521).

• Database User Name - Enter the same user name that you specified when you created the 
schema for the Master Repository in Chapter 7: Configuring Oracle Data Integrator (see Step 
1: Import the Database .DMP File for OII on page 57). 

• Password - Enter the same password that you specified when you created the schema for the 
Master Repository in Chapter 7: Configuring Oracle Data Integrator (see Step 1: Import the 
Database .DMP File for OII on page 57). 

• Confirm Password - Retype your password.
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10. Click Next. The following screen appears.

Figure 149: Test the Database Connection

11. Click the Test Configuration button to test the connection. A message will appear at the top of 
the screen to indicate that a connection to the database using the properties you provided was 
successful.

Figure 150: Successful Database Connection Message

12. Click Next. The Select Target screen opens.
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13. Click Next. The following screen opens.

Figure 151: Select Target

14. Select AdminServer and click Finish. You will be returned to the Data Sources screen where the 
new data source will be listed.

Figure 152: New Data Source

15. Click the Activate Changes button in the Change Center section on the left pane.

WHAT’S THE NEXT STEP IN THE INSTALLATION?
The next step is to upgrade to OII 7.0.2 by performing the steps described in:

• Chapter 13: Copy the app Directory
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Chapter 13 

Copy the app Directory
1. Locate the directory: <Insight702Package>\app

For example: C:\Insight702Package\app

Figure 153: <Insight702Package>\app

2. Copy the folder: <Insight702Package>\app

to: <OII_ROOT>\app

For example: C:\Oracle\Insight_Home\Insurance\oii\7.0.0\app

WHAT’S THE NEXT STEP IN THE INSTALLATION?
This completes the installation of OII 7.0.2.
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Chapter 14

Upgrading to OII 7.0.2
This chapter is intended for users who have already installed OII 7.0 or OII 7.0.1 on their system and 
are only upgrading to OII 7.0.2. The upgrade process consists of the following steps:

Table 3: Upgrade Road Map

Step Description

Step 1 Install OBIEE 11g and RCU 11g

Step 2 Install Oracle Data Integrator 11g (11.1.1.5.0) 

Step 3 Update the ODI Repositories

Step 4 Download the OII 7.0.2 Upgrade Package

Step 5 Edit the application.properties File

Step 6 Run the OII 7.0.2 Upgrade Utility

Step 7 Create a Database Connection

Step 8 Deploy the OII 7.0.2 Repository

Step 9 Update the Connection Information to the OII Repository

Step 10 Configure Security Settings for OII (optional)

Step 11 Deploy the OII Catalog and System Files

Step 12 Deploy the MetaData Dictionary

Step 13 Import the Warehouse Palette application into APEX

Step 14 Deploy the ODI Service Wrapper

Step 15 Update the Credential Store

Step 16 Copy the OII 7.0.2 app\ directory to the 7.0 app\ directory
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STEP 1: INSTALL OBIEE 11G AND RCU 11G
OBIEE 11g replaces OBIEE 10g in OII 7.0.2. In addition, you must also install the Repository 
Creation Utility (RCU) which is used to create the required database schemas for OBIEE prior to 
installing OBIEE 11g. 
Refer to Chapter 3: Installing the Prerequisite Software for OII for the links to download OBIEE 11g 
and RCU from the Oracle Technology Network.

STEP 2: INSTALL ODI 11G (11.1.1.5.0)
OII 7.0.2 requires ODI (11.1.1.5.0) to be installed on your system. It replaces the previous version of 
ODI (11.1.1.3.0).
Refer to Chapter 3: Installing the Prerequisite Software for OII for the links to download ODI 
11.1.1.5.0 from the Oracle Technology Network.

STEP 3: UPDATE THE ODI REPOSITORIES
1. Run the Upgrade Assistant utility: <ODI_HOME>\bin\ua.bat

For example: C:\Oracle\product\11.1.1\Oracle_ODI_1\bin\ua.bat

2. Open ODI Studio by selecting:

Start>All Programs>Oracle>Oracle Data Integrator>ODI Studio

Before ODI Studio opens the following message will appear:

Figure 154: Select “Yes” to Import Preferences

3. Select Yes.

4. Ensure that you can connect to the Master and Work repositories (referr to the steps in Chapter 
7: Configuring Oracle Data Integrator).
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STEP 4: DOWNLOAD THE OII 7.0.2 UPGRADE PACKAGE
The OII Upgrade Package for OII 7.0.2 is available from the Oracle E-Delivery system as a .ZIP file 
at: http://edelivery.oracle.com.

1. Obtain the OII upgrade ZIP file (e.g., Insight702Package.zip) from Oracle E-Delivery and 
download it to your machine. 

2. Unzip the upgrade package. It will place a folder on your system bearing the same name as the 
ZIP file (e.g., Insight702Package). The following files and directories will appear under the 
unzipped folder:

Figure 155: Upgrade Files for OII 7.0.2

WHAT’S IN THE UPGRADE PACKAGE?

root folder
• version.txt - A text file containing the version of the package.

• 702Upgrade.jar - The main upgrade utility, executable jar file.

• application.properties - A configuration file that contains the parameters for the upgrade utility.

• upgrade.bat - A windows batch file to execute the upgrade utility.

• upgrade.sh - A UNIX script file to execute the upgrade utility.

app folder
The app folder contains the updated content for agent and additional content for OII 7.0.2. 
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install folder
The install folder contains the updated content for APEX, the database, OBIEE and the ODI Wrapper 
Service:

apex
This folder contains the updated version of the Warehouse Palette application, wp_apex.sql.

db
This folder contains all database related updates. 

obiee
This folder contains all OBIEE related updates.

wrapper
This folder contains the updated version of the OdiWrapperService.ear file.
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STEP 5: EDIT THE APPLICATION.PROPERTIES FILE
1. Open the <Insight702Package>\application.properties file.

For example: C:\Insight702Package\application.properties

Figure 156: The <Insight702Package>\application.properties File

2. Update the corresponding parameters for your system.

Figure 157: Contents of the application.properties File

3. Save and close the <Insight702Package>\application.properties file. 
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STEP 6: RUN THE OII 7.0.2 UPGRADE UTILITY
1. Open a command prompt window.

2. Run the upgrade utility: <Insight702Package>\upgrade.bat

For example: C:\Insight702Package\upgrade.bat

Once executed you will be prompted for a series of password. These are the same passwords that 
you entered on the Schema Configuration Parameters screen in Chapter 5: Installing OII 7.0 
on page 25.

3. Follow the prompts on the screen and supply the proper passwords as required.

Figure 158: Running the Upgrade Utility on Windows

STEP 7: CREATE A DATABASE CONNECTION
Define a database connection named Insight700 using the Net Manager tool that is installed with 
OBIEE 11g. You will need this connection later on when configuring Oracle Data Integrator and 
OBIEE.
Refer to Chapter 4: Creating a Database Connection for the full instructions for accessing Net 
Manager and creation the database connection.
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STEP 8: DEPLOY THE OII 7.0.2 REPOSITORY
Follow the steps in this section to deploy the Insight_702.rpd to OBIEE.

SUB-STEP A: COPY THE OII 7.0.2 REPOSITORY TO OBIEE
1. Locate the OII 7.0.2 repository file for OBIEE, Insight_702.rpd, under:

<Insight702Package>\install\obiee\repo\Insight_702.rpd 
For example:
C:\Insight702Package\install\obiee\repo\Insight_702.rpd 

Figure 159: The OII 7.0.2 Repository File for OBIEE

2. Copy Insight_702.rpd to the repository folder under:
<MW_HOME>\instances\<instance#>\<domain_name>\OracleBIServerComponent\
coreapplication_obips1\repository

For example:
C:\Oracle\Middleware\instances\instance1\bifoundation\OracleBIServerComponent\
coreapplication_obips1\repository
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SUB-STEP B: CREATE THE INSIGHT_7 FOLDER
1. Create an empty folder named Insight_7 under 
<MW_HOME>\instances\<instance#>\<domain_name>\OracleBIPresentationServicesComponent\ 
coreapplication_obips1\catalog

For example:
C:\Oracle\Middleware\instances\instance1\<domain_name>\OracleBIPresentationServicesComponent\ 
coreapplication_obips1\catalog
The full path to with the Insight_7 folder will now appear as:
C:\Oracle\Middleware\instances\instance1\<domain_name>\OracleBIPresentationServicesComponent\ 
coreapplication_obips1\catalog\Insight_7

SUB-STEP C: DEPLOY THE OII REPOSITORY
1. Log into Enterprise Manager (see Opening the Oracle Fusion Middleware Control on page 12 in 

Chapter 3: Installing the Prerequisite Software for OII). The Oracle Fusion Middleware Console 
will open.

Figure 160: Oracle Fusion Middleware Console

2. From the navigation tree on the left, select Farm_<domain_name>Business Intelligence> 
coreapplication. 
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3. In the screen on the left, click on the Deployment tab and then select the Repository tab. The 
following screen opens:

Figure 161: Repository Tab

4. Click on the Lock and Edit Configuration button on the top to lock the current domain for 
editing.

Figure 162: Lock and Edit Configuration Button

5. Under the Upload BI Server Repository section, click on the Browse button and locate the 
Insight_702.rpd repository file. This is the same repository file that you copied to the OBIEE 
Server repository directory in Step 8: Deploy the OII 7.0.2 Repository on page 135.

For example:
C:\Oracle\Middleware\instances\instance1\<domain_name>\OracleBIServerComponent\
coreapplication_obips1\repository
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6. Once you have uploaded the file, enter the following default repository password, twice: 
 
welcome1

Figure 163: Enter the Repository Password

7. Under the BI Presentation Catalog section, enter the full path to the Insight_7 catalog folder in 
the Catalog Location field that you created in Sub-step B: Create the Insight_7 Folder on page 
136. The full path to the Insight_7 folder is:

<MW_HOME>\instances\<instance#>\<domain_name>\OracleBIPresentationServicesComponent\ 
coreapplication_obips1\catalog\Insight_7

For example:
C:\Oracle\Middleware\instances\instance1\<domain_name>\OracleBIPresentationServicesComponent\ 
coreapplication_obips1\catalog\Insight_7

8. Click on the Apply button in the BI Server Repository section to save the changes.

Figure 164: Select Apply Button

At this point, the RPD is assigned a sequence number after it, and it is displayed as the current default 
online repository for the Oracle BI Domain (e.g., Insight_702_BI0003).

Figure 165: The RPD is Assigned a Sequence Number
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9. Select the Activate Changes button on top.

Figure 166: Select the Activate Changes Button

10. Click on the Capacity Management tab and then the Availability tab.

11. Click on the Restart All button to restart the services. A dialog box will appear and ask you to 
confirm your action to restart the services.

Figure 167: Select the “Restart All” Button

12. Click the Yes button in the dialog box to proceed with the restart. A message will appear to 
confirm that all services have restarted.
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STEP 9: UPDATE THE CONNECTION INFORMATION TO THE OII 
REPOSITORY

Update the OII repository connection information for the OII Subject Areas.

SUB-STEP A: OPEN THE OBIEE REPOSITORY
1. Open the OBIEE Repository Administration Tool by selecting:

Start>All Programs>Oracle Business Intelligence>Administration

2. When the Administration Tool opens, select File>Open>Online to display the Online 
Repository dialog box.

3. In the login dialog box that appears, enter the repository password (the default password is 
welcome1) and click on OK.

4. Enter a valid user name and password. The default user name is weblogic and whatever password 
you selected when you installed OBIEE.

The following Repository screen will open:

Figure 168: Layers of the OBIEE Repository for OII
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SUB-STEP B: UPDATE THE “LINE OF BUSINESS” SUBJECT AREAS
1. Go to the Physical Layer pane.  

 
This pane contains the Subject Areas for each Line of Business (Commercial Auto, Homeowners, 
etc.) and an additional Subject Area called Insight700Config. You will need to configure the 
settings under each of the Line of Business Subject Areas and the Insight700Config Subject 
Area.

2. Expand each of the Line of Business Subject Areas under the Physical Layer pane. The 
Connection Pool icon will appear underneath each Subject Area:

Figure 169: Subject Areas under the Physical Layer

3. Starting with the Commercial Auto Subject Area, click on the Connection Pool icon.

Figure 170: Connection Pool Icon

4. A message box will appear and ask you if you want to check out the Connection Pool.



Chapter 14 – Upgrading to OII 7.0.2

142

5. Select Yes. The Connection Pool screen opens:

Figure 171: “Commercial Auto” Connection Pool Screen
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6. Make sure that the Require fully qualified table names option is unchecked. 

7. Under the “Shared Login” section, enter the same user name and password that you entered on 
the Schema Configuration Parameters screen for the Data Mart Schema (see page 33 in 
Chapter 5: Installing OII 7.0).

Figure 172: Data Mart Schema User Name and Password on the Schema Configuration Parameters Screen

8. Leave all of the other settings as is and click OK to close the screen.

9. Repeat steps 1-8 for each of the remaining Line of Business Subject Areas.

Note The default user name is OII_DM. If you entered a different user name on the Schema 
Configuration Parameters screen, use that name here.
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SUB-STEP C: CONFIGURE THE INSIGHT700CONFIG SUBJECT AREA
1. Click on the Connection Pool under the Insight700Config Subject Area to open the Connection 

Pool window. 

Figure 173: Insight700Config Connection Pool Window

2. Make sure the data source name is Insight700Config.

3. Make sure that the Require fully qualified table names option is unchecked. 
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4. Under the “Shared Login” section, enter the same user name and password that you entered on 
the Schema Configuration Parameters screen for the System Configuration Schema (see page 
33 in Chapter 5: Installing OII 7.0).

Figure 174: System Configuration Schema User Name and Password on the Schema Configuration Parameters Screen

5. Click OK to close the screen.

Note The default user name is OII_SYS. If you entered a different user name on the Schema 
Configuration Parameters screen, use that name here.
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STEP 10: CONFIGURE SECURITY SETTINGS FOR OII (OPTIONAL)
The OII system administrator can assign one or more of the following OII application roles to an OII 
user. The assigned role(s) determines which OII reports will be available to the users when they log 
into OBIEE. 

• Actuary

• Claims Management

• Executive

• Production

• Underwriting

If you wish to assign individual roles to users, use the Oracle Fusion Middleware Control to create 
and configure the necessary OII application roles, security groups, and user accounts to ensure that 
OII users are granted access to the proper data within OBIEE. Refer to the OII System Administration 
Guide for the complete instructions on configuring the security settings for OII.
If you do not wish to assign individual roles to a user, you can skip this step and use the default 
OBIEE login (welcome/weblogic1) or any user with administrative privileges to log into OBIEE. Any 
user with administrative privileges will have access to all of the OII reports.

STEP 11: DEPLOY THE OII CATALOG AND SYSTEM FILES
Follow the steps in this section to deploy the OII catalog and system files.

1. Open a new browser window and enter the following URL: 
 
http://<hostname>:<port>/analytics 

Note Refer to the OII User’s Guide for a specific description of the OII reports availabe to each 
application role.

Note In the above URL:

• <hostname> - is the server name or IP address where you installed OBIEE 

• <port> - is the port assigned to OBIEE. The default port will be different 
depending on whether or not you selected a “Simple” or “Enterprise” Install for 
OBIEE.

• Simple Install - the default port is 7001.

• Enterprise Install - the default port is 9704 but the user has the option to 
specify ports during the installation.
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2. The OBIEE front-end login screen will appear.

Figure 175: Oracle Business Intelligence Login Screen

3. Login using the default User ID and Password (weblogic/welcome1) or any user account with 
administrator priveleges.

The default OBIEE home page appears.

Figure 176: OBIEE Default Home Page
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4. Select the Catalog button on the top bar.

Figure 177: Select the Catalog Button

The Catalog page opens:

Figure 178: Catalog Page

5. Click on Shared Folders in the top of the left pane.

6. Click on Unarchive in the bottom of the left pane. The Unarchive dialog box opens.

Figure 179: Unarchive Dialog Box

7. Select the Browse button to locate the.catalog folder under the OII 7.0.2 upgrade package:

<Insight702Package>\install\obiee\catalog

For example: 

C:\Insight702Package\install\obiee\catalog
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This folder contains the following catalog files:

Figure 180: Catalog Files in <Insight702Package>\install\obiee\catalog

8. Select the first catalog file in the list (e.g., Commercial Auto.catalog) and click the Open button. 
The File Upload dialog box will close and the Commercial Auto.catalog file will appear in the 
Archive file field in the Unarchive box.

9. Select the following options in the Unarchive box:

• Replace - Select All.

• ACL - Select Preserve.

Figure 181: Unarchive Box with Selected Catalog file

10. Click OK.

11. Repeat steps 6-10 for the remaining catalog files.
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12. Logout of OBIEE.

13. Go to the <Insight702Package>\install\obiee\catalog folder and copy the system folder to the 
following location:

<MW_HOME>\instances\<instance#>\<domain_name>\OracleBIPresentationServicesComponent\
coreapplication_obips1\catalog\Insight_7\root\system
For example:
C:\Oracle\Middleware\\instances\instance1\<domain_name>\OracleBIPresentationServicesComponent\ 
coreapplication_obips1\catalog\Insight_7\root\system

14. Log back into OBIEE and verify that all OII Scorecard and Analysis Dashboards as well as all 
OII Reports are present as well as all system level default data formats.

Figure 182: OII Scorecard and Analysis Dashboards

Figure 183: OII Executive Reports
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STEP 12: DEPLOY THE METADATA DICTIONARY
Follow the steps in this section to deploy the OII MetaData Dictionary.

SUB-STEP A: DEPLOY THE ANALYTICSRES FOLDER
1. Locate the analyticsRes folder under: 
<MW_HOME>\instances\<instance #>\<domain_name>\OracleBIPresentationServicesComponent\
coreapplication_obips1\analyticsRes

For example:
C:\Oracle\Middleware\instances\instance1\<domain_name>\OracleBIPresentationServicesComponent\ 
coreapplication_obips1\analyticsRes

2. Copy the analyticsRes folder to your Middleware home directory: <MW_HOME>

For example: C:\Oracle\Middleware

The folder, analyticsRes, now rests at the base of your Middleware home directory. For example:

C:\Oracle\Middleware\analyticsRes

3. Log into the Oracle WebLogic Server Administration Console (see Opening the Oracle 
WebLogic Server Administration Console on page 13 in Chapter 3: Installing the Prerequisite 
Software for OII).

4. Click on the Deployments link in the Domain Structure pane. The Summary of Deployments 
screen will open. 

Figure 184: Summary of Deployments Screen
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5. Click the Lock & Edit button in the Change Center section in the left pane. 

6. Click the Install button on the Deployments table. The Install Application Assistant screen will 
open.

7. In the Path: box, enter the path to the <MW_HOME>\analyticsRes directory where you copied 
the analyticsRes folder. 

Figure 185: Enter the path to <MW_Home>\analtyicsRES

8. The screen will refresh and a radio button for analyticsRes will appear on the screen.

Figure 186: analytics Res
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9. Select the analyticsRes radio button and click Next.  The following screen appears:

Figure 187: Accept the Default Targeting Style
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10. Accept the default settings on this screen and click Next. The following screen appears. 

Figure 188: Deploy the analyticsRes Application

11. Go down to the “Source Accessibility” section of the screen and select:

I will make the deployment accessible from the following location

12. Click Finish. 



Step 12: Deploy the MetaData Dictionary

155

13. Click the Activate Changes button in the Change Center section on the left pane.

Figure 189: Select “Activate Changes” Button

14. You will be returned to the Summary of Deployments screen where you will see the analyticsRes 
application deployed. 

15. If the analyticsRes application is not “Active” then start it by first selecting analyticsRes and 
then clicking the Start>Servicing all requests. 

Figure 190: Start the AnalyticsRes Application

16. If the deployment was successful, the “State” column corresponding to analyticsRes application 
should show “Active” and the “Health” column should show “OK”. 
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SUB-STEP B: UPDATE THE INSTANCECONFIG.XML FILE
1. Open the instanceconfig.xml file located at:
<MW_HOME>\instances\<instance#>\config\OracleBIPresentationServicesComponent\
coreapplication_obips1\instanceconfig.xml

For example:
C:\Oracle\Middleware\instances\instance1\config\OracleBIPresentationServicesComponent\
coreapplication_obips1\instanceconfig.xml

2. Before the </ServerInstance> tag, add the following entry

<SubjectAreaMetadata>
<DictionaryURLPrefix>/analyticsRes/</DictionaryURLPrefix>
</SubjectAreaMetadata>

3. Save and close the file.

SUB-STEP C: COPY THE INSIGHT_702 FOLDER
1. Open the following folder under the 7.0.2 upgrade folder:

<Insight702Package>\install\obiee\metadata_dic 

For example: 

C:\Insight702Package\install\obiee\metadata_dic

2. You will see a single folder called Insight_702.

3. Copy the entire Insight_702 folder to:

<MW_HOME>\analyticsRes

For example:

C:\Oracle\Middleware\analyticsRes

The folder, Insight_702, now rests at the base of the analyticsRes folder. For example:

C:\Oracle\Middleware\analyticsRes\Insight_702

Important Once the copy is complete, go into the Insight_702 folder and make sure you have at 
least 36,000 files and over 1600 folders in total for this folder. If not extracted properly, 
some files may become lost during the transfer due to the long path/file name.
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4. :Rename the Insight_702 folder to match the name of the repository file you deployed in Sub-
step C: Deploy the OII Repository on page 136 (e.g., Insight_702_BI0003).

Figure 191: Rename the Insight_702 Folder to Match the Name of the Deployed Repository File

For example:
C:\Oracle\Middleware\analyticsRes\Insight_702_B10003

5. Log back into Enterprise Manager (see Opening the Oracle Fusion Middleware Control on page 
12 in Chapter 3: Installing the Prerequisite Software for OII). The Oracle Fusion Middleware 
Console will open.

6. From the navigation tree on the left, expand Farm_<domain_name>Business Intelligence> 
coreapplication. 

7. Select the Capacity Management tab in the screen on the right.

8. Select the Restart All button to select all services.
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SUB-STEP D: TEST THE METADATA DICTIONARY OBIEE
1. Log into OBIEE (refer to the instructions on page 146).

2. From the lower menu, click New. The following list of options opens.

Figure 192: List of Available Options

3. Select Analysis. A list of OII Subject Areas opens.

Figure 193: Select Subject Areas
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4. Click on a Subject Area. The Analysis Editor opens.

Figure 194: Analysis Editor

5. In the Subject Areas pane on the left click on either the name of the subject area, the Metrics 
folder, or the name of a Filters folder.

6. Click on the Metadata Dictionary button in the upper right of the Subject Areas pane. 

Figure 195: Select the Metadata Dictionary Button
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The OII MetaData Dictionary will open in a separate browser screen. This screen will show details 
whatever item you selected in the Subject Area pane. The example below shows data for the Metrics 
folder.

Figure 196: OII MetaData Dictionary

Note Refer to the OII User’s Guide for further information about viewing information in the OII 
MetaData Dictionary.
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STEP 13: IMPORT THE WAREHOUSE PALETTE APPLICATION INTO 
APEX

In the APEX Administration Service Console users must delete the current Warehouse Palette 
Application, wp_apex.sql, and then deploy the updated wp_apex.sql application for OII 7.0.2.

SUB-STEP A: DELETE THE CURRENT WAREHOUSE PALETTE 
APPLICATION 

1. Enter the following URL in your browser: 
 
http://<hostname>:<port>/apex

where:

• hostname - the host name where the WebLogic application server is installed.

• port - is the port number assigned to the WebLogic Application Server. The default port for 
the Oracle Application Express Listener deployed on WebLogic is 7001. If the WebLogic 
Application Server was configured on a different port, then use that port.

• apex - the mount point defined in the Web Server configuration file.

For example:
http://host_name:7001/apex

The following Login screen will open.

Figure 197: Login Screen for the Warehouse Palette Workspace

2. Enter the Workspace, Username, and Password for the Warehouse Palette workspace. In this 
example the Workspace name is OII_WP.
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3. Select the Application Builder icon. The Application Builder screen will open. 

Figure 198: Sample Application

4. Click on Warehouse Palette. The page for the Warehouse Palette application screen will open.

Figure 199: Contents of the Warehouse Palette Application
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5. Click on the Edit Application Properties. The Edit Application screen will open.

Figure 200: Application Properties for Warehouse Palette

6. Click on the Delete button. A message screen will appear asking you to confirm your decision.

Figure 201: Confirm Deletion of Sample Application

7. Click the Permanently Delete Now button.

8. You will be returned to the All Applications tab on the Application Builder screen. A message 
at the top of the screen will inform you that the Sample Application has been deleted.



Chapter 14 – Upgrading to OII 7.0.2

164

SUB-STEP B: DEPLOY THE OII 7.0.2 WAREHOUSE PALETTE APPLICATION
1. On the Application Builder page, click on the Import button.

Figure 202: Import Button

2. The Specify File page opens:

Figure 203: Specify File Page

3. For the Specify File box, select the following:

• Import File - Use the Browse button to locate the wp_apex.sql file under the upgrade folder 
for OII 7.0.2: 
 
<Insight702Package>\install\apex\wp_apex.sql

For example:

C:\Insight702Package\install\apex\wp_apex.sql

• File Type - Select Database Application, Page or Component Export.

• File Character Set - Keep the File Character Set default.
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4. Click Next. The screen refreshes and message will inform you that the import was successful.

Figure 204: File Import Confirmed

5. Click Next. The Install Application screen opens.

Figure 205: Install Application

6. On the Install Application screen, select the following:

• Parsing Schema - Select the “OII_WP” schema.

• Build Status - Select “Run and Build Application”.

• Install as Application - The option allow you to avoid application ID conflicts. The 
application ID is part of the URL that is used to access the Warehouse Palette. For example:

http://<hostname>:<port>/apex/f?p=101:1

There are three options listed here but you only need to select either:

• Reuse Application ID From Export File - An Application ID of 101 is automatically 
assigned to the Warehouse Palette during the OII installation. If you choose this option 
then 101 will be used as the application ID for Warehouse Palette as shown in the sample 
URL above.

• Auto Assign New Application ID - This option automatically assigns a unique 
application ID within APEX. If you select this option make note of the new application 
ID and include it in the URL. 

http://%3chostname%3e:%3cport%3e/apex/f?p=101:1
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7. Click Install. You will be returned to the Application Builder page. The newly installed 
Warehouse Palette application will appear on this page.

Figure 206: The Warehouse Palette has been Redeployed
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STEP 14: DEPLOY THE ODI SERVICE WRAPPER
1. Log into the Oracle WebLogic Server Administration Console (see Opening the Oracle 

WebLogic Server Administration Console on page 13 in Chapter 3: Installing the Prerequisite 
Software for OII). The WebLogic Administration Console opens:

Figure 207: WebLogic Server Administration Console

2. Click the Depolyments link under the Domain Structure pane. The Deployments screen will 
open.

Figure 208: Deployments Screen
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3. Click the Lock & Edit button in the Change Center section in the left pane. 

4. Check the box next to “ODIWrapperService”.

5. Click the Delete button to remove “ODIWrapperService”. 

Figure 209: Delete the Currently Deployed ODIWrapperService

6. Click the Install button. The Install Application Assistant screen will open.

Figure 210: Install Application Assistant Screen

7. In the Path: box, enter the full path to the OdiWrapperService.ear file that is located under the 
upgrade folder for OII 7.0.2:  
 
<Insight702Package>\install\wrapper\OdiWrapperService.ear

For example:

C:\Insight702Package\install\wrapper\OdiWrapperService.ear
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8. Click the Next button. The screen will refresh and a radio button for the 
OdiWrapperService.ear file will appear on the screen. 

Figure 211: The OdiWrapperService.ear File Radio Button

9. Select the OdiWrapperService.ear radio button.

10. Click the Next button. The following screen will open.

Figure 212: Choose Targeting Style
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11. Select Install this deployment as an application and click Next. The “Optional Settings” screen 
opens.

Figure 213: Source Accessibility Section

12. Scroll down to the “Source Accessibility” section of the screen and select:  
 
I will make the deployment accessible from the following location.

13. Click the Finish button.

14. After the OdiWrapperService.ear file has been deployed, you will be returned to the Summary 
of Deployments screen. The OdiWrapperService.ear file will be listed on the screen. 

Figure 214: OdiWrapperService.ear File is Successfully Deployed
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15. To start the service, check OdiWrapperService.ear in the Deployments table and then click 
Start>Servicing all requests. 

Figure 215: Start the ODIWrapperService
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STEP 15: UPDATE THE CREDENTIAL STORE

To upgrade to OII 7.0.2 you must update the credential store by replacing the existing credential, 
DBAUSER, with SYSUSER.

1. Open a command prompt and go to: <OII_Root>app\csutil\bin 

For example:  
 
C:\Oracle\Insight_Home\Insurance\oii\7.0.0\app\csutil\bin 

2. At the command line, type the following command and press Enter.

You will be prompted for a key name: 

3. Type DBAUSER and press Enter. A message will confirm that the DBAUSER credential has 
been deleted: 

4. To add the SYSUSER credential, type the command below and press Enter. Replace password 
with the corresponding password you entered for OII_SYS on the Schema Configuration 
Parameters screen during the OII installation. A message will appear to confirm that the 
SYSUSER credential has been added. 

IMPORTANT This step should only be performed if you are upgrading directly from OII 7.0. 
If you are upgrading from OII 7.0.1 you can skip this step.

delete

Enter key: 

Enter key: DBAUSER
Credential removed: DBAUSER

add SYSUSER OII_SYS password
Credential added :SYSUSER
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STEP 16: COPY THE APP DIRECTORY
1. Locate the directory: <Insight702Package>\app

For example: C:\Insight702Package\app

Figure 216: <Insight702Package>\app

2. Copy the folder: <Insight702Package>\app

to: <OII_ROOT>\app

For example: C:\Oracle\Insight_Home\Insurance\oii\7.0.0\app

Figure 217: <OII_Root>\app
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Appendix A

Scheduling the Warehouse Palette Agent
This appendix describes how to setup the Warehouse Palette agent to run as a Windows 
service. 

1. On your computer, open the Control Panel and select Scheduled Tasks from the list of 
options.

2. Click on Add Scheduled Tasks. This will open the Scheduled Task Wizard.

Figure 218: Scheduled Task Wizard
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3. Click Next. The Browse window opens.

Figure 219: Locate agent_start

4. Use the Browse button to find and select Warehouse Palette agent startup file:

<OII_ROOT>\app\agent\bin\agent_start.bat

For example:

C:\Oracle\Insight_Home\Insurance\oii\7.0.0\app\agent\bin\agent_start.bat

The file name (agent_start) will appear in the following window.

Figure 220: Schedule Time to Run agent_start
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5. Select When my computer starts from the choice list and click Next. The following window 
appears.

Figure 221: User Name and Password

6. Enter a user name and password of your choice and click Next. The following window appears:

Figure 222: Finish Window
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7. Click Finish. The agent_start file will appear in the list of scheduled tasks. The Warehouse 
Palette agent will now start when your computer starts.

Figure 223: agent_start is Scheduled

Note You can also start the Warehouse Palette agent by right-clicking on agent_start in 
this window and selecting Run from the pop up menu.
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